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Parallels Desktop Switch to Mac is designed to help you move the whole of your PC to your 
Mac in three easy steps. 

1. Learn your Mac 

If you are new to Mac OS X, watch the educational tutorials included in Parallels Desktop 
Switch to Mac to learn about all Mac features. Once you’ve learned your Mac, you are ready to 
make the move. 

2. Migrate  

Moving your Windows with Parallels Desktop Switch to Mac is as easy as plug and click. The 
Parallels USB cable and Parallels Transporter (p. 18) move everything - the Windows 
installation, applications, and files - right to your Mac. For successful migration you need the 
following components: 

 Parallels USB cable. 
 Parallels Transporter Agent installed on your Windows computer. It will collect the data and 

transfer it to Parallels Transporter using USB cable, network, or an external storage device. 
 Parallels Transporter installed on your Mac. Parallels Transporter is installed together with 

Parallels Desktop Switch to Mac. This application receives data from Parallels Transporter 
Agent and transfers it to a Parallels virtual machine on your Mac. 

 

To move your Windows computer to your Mac, connect the computers using the Parallels USB 
Cable, start Parallels Transporter and Parallels Transporter Agent, and follow the assistant. You 
can also transfer your Windows computer over network or using an external storage device. 

3. Run Windows on your Mac 

When your PC is transferred to a virtual machine on your Mac, you can work in Windows 
applications side-by-side with your Mac applications without any need to restart the computer. 
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This chapter lists system requirements for your Mac and the source computer. Before you start 
migrating, make sure that your computers meet these requirements. 

In This Chapter 
Mac Requirements ................................................................................................................ 5 
Source Computer System Requirements............................................................................... 6 
 
 

Mac Requirements 
Parallels Desktop Switch to Mac can be installed on any Intel-based Mac that complies with the 
requirements listed here. 

Hardware Requirements 
 Any Macintosh computer with an Intel processor (1.66 GHz or greater). To run 64-bit 

operating systems in virtual machines, an Intel Core 2 or later processor is required. 
 Minimum 1 GB of memory, 2 GB of memory is recommended. 

Note: Your Mac must have enough memory to run Mac OS X and your Mac applications, 
plus the memory required for the virtual machine guest operating system and the 
applications installed in it. 

 At least 1 GB of disk space on the boot volume (Macintosh HD) for Parallels Desktop Switch 
to Mac installation. 

 About 15 GB of disk space for each virtual machine. 

Software Requirements 
 Mac OS X v10.6.3 Snow Leopard or later 
 Mac OS X v10.5.8 Leopard or later 

To get information about your Mac OS X version, type of processor, and amount of memory, 
choose About This Mac from the Apple menu. 
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Source Computer System 
Requirements 

To migrate data from a physical computer, you need to install Parallels Transporter Agent on it. 
Parallels Transporter Agent can be downloaded from the Parallels Download Center and 
installed on computers that meet the following requirements. 

Hardware Requirements 
 700 (or higher) MHz x86 or x64 processor (Intel or AMD). 
 256 MB or more of RAM. 
 50 MB of hard disk space for installing the Parallels Transporter Agent package. 
 Ethernet or WiFi network adapter for migrating over network. 
 USB port for migrating using the Parallels USB cable. 

Supported Windows Systems 
OS Name 32-bit 64-bit Migration Method 

Windows 7   USB, Network, External Storage 

Windows Vista® 

Ultimate, Enterprise, Business, 
Home SP0, SP1, SP2 

  USB, Network, External Storage 

Windows Server® 2003 

Standard, Enterprise, Web SP2   Network, External Storage 

Windows XP 

Home, Professional SP2, SP3   USB, Network, External Storage 

Windows 2000 

Professional   External Storage 

Warning! OEM Windows operating systems may not work with Parallels Desktop after you 
migrate them to virtual machines. OEM operating systems are only distributed when they are 
sold with computers. The best example of an OEM operating system is the copy of Windows 
that comes pre-installed when you buy a new PC. 

Supported Linux Systems 
OS Name 32-bit 64-bit Migration Method 

Red Hat® Enterprise Linux 5   Network, External Storage 

Ubuntu® Linux 8.04   Network, External Storage 

Supported File Systems 
 FAT16/32 (Windows only) 
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 NTFS (Windows only) 
 Ext2/Ext3 

Parallels Transporter does not support migrating Windows dynamic volumes and Linux logical 
volumes (LVM). If the file system is not supported, Parallels Transporter copies all disk sectors 
successively and you may experience problems using the resulting virtual machine. 
 



 

 8 
 

To be able to migrate your PC to a virtual machine on your Mac, you need to install Parallels 
Desktop Switch to Mac on your Mac and Parallels Transporter Agent on the PC that you are 
going to migrate. In this chapter, you will find the detailed system requirements for both 
computers as well as step-by-step installation instructions. 

In This Chapter 
Installing Parallels Desktop................................................................................................... 8 
Installing Parallels Transporter Agent................................................................................... 10 
Removing Parallels Transporter Agent ................................................................................. 13 
 
 

Installing Parallels Desktop 
To install Switch to Mac, insert the Switch to Mac installation disc into the optical drive of your 
Mac, open the Switch to Mac DMG package, and double-click Install. 

1 Parallels Desktop Switch to Mac will connect to the Parallels update server and check for 
available updates. If there is a newer version of Parallels Desktop Switch to Mac available, 
you will be offered the most recent version of Parallels Desktop Switch to Mac. If you do 
not want to install the most recent version, you can choose to install the version from the 
installation media. 
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 If you click Install current, Parallels Desktop will be installed from the installation 
media. 

 If you click Download and install new version, the latest version of Parallels Desktop will 
be downloaded and installed on your Mac. 

If there is no update available or your Mac is not connected to the Internet, Parallels Desktop 
will be installed from the current installation source. 

2 In the Welcome window, click Continue. 

3 In the Important Information window, read the product Read Me file. Click Print to print the 
document or Save to save it for future reading. When finished, click Continue. 

 

Note: You can return to the previous steps by clicking the Go Back button. 

4 In the Software License Agreement window, carefully read the license agreement. We 
recommend to print the license agreement for your records using the Print button or to save 
it for future reading using the Save button. When you are ready, click Continue. 
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In the pop-up dialog, click Agree if you agree with the terms and conditions of the license 
agreement. 

5 In the Select a Destination window, select the hard disk where to install Parallels Desktop. 
You can install Parallels Desktop only on the boot volume, that is the hard disk where Mac 
OS X is installed. Other disks, if any, are unavailable for selection. Click Continue. 

Note: If you have only one volume on your Mac, this step is omitted. 

6 Click Install to start the Parallels Desktop installation. 

7 Enter your password when prompted and click OK. 

8 The installation progress is shown in the Installing Parallels Desktop window. 

9 The Installer informs you that the installation was successful. To complete the installation, 
click Close. 

After the installation, you can launch Parallels Desktop from the Applications folder on 
your Mac. The Parallels Desktop add-ons like Parallels Transporter and Parallels Mounter are 
available from the /Mac HD/Library/Parallels/ folder. 
 

Installing Parallels Transporter 
Agent 

This section provides instructions on installing Parallels Transporter Agent on your source 
computer. 
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Installing Parallels Transporter Agent in Windows 
To begin the Parallels Transporter Agent installation, insert the installation DVD in your 
CD/DVD-ROM drive and the installation will start automatically. If it does not start 
automatically, locate the Parallels Transporter Agent.exe file on the disk. 

If your computer cannot read DVD discs, download Parallels Transporter Agent for Windows 
from the Parallels Download Center. 

Note: You must have administrator rights to install Parallels Transporter Agent. 

Installing Parallels Transporter Agent 
If the Parallels Transporter Agent installation has not started automatically, double-click the 
installation file. Parallels Transporter Agent will connect to the Parallels update server and 
check for available updates. If there is a newer version of Parallels Transporter Agent 
available, you will be offered the most recent version of Parallels Transporter Agent. If you 
want to install the most recent version, click Download and install new version. If you want 
to install the current version, click Install current. 
If there is no update available or your computer is not connected to the internet, Parallels 
Transporter Agent will be installed from the current installation source. 

1 In the Welcome window, click Next. 
2 In the License Agreement window, carefully read the Parallels end user license agreement. 

Click the Print button to print the document. If you agree with the stated terms and 
conditions, select I accept the terms in the license agreement and click Next. 
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3 In the Destination Folder window, specify the folder where Parallels Transporter Agent will 
be installed and click Next. If you do not want to install to the default folder, click the 
Change button and specify your folder. 

 
4 In the Ready to Install the Program window, click Install to start the installation. 

5 After the installation is complete, click Finish to exit the wizard. 

Installing the Parallels USB Cable Driver in Windows XP 

If you are going to migrate the Windows physical computer to a Parallels virtual machine on 
your Mac using the Parallels USB cable, you need to install the Parallels USB cable driver on 
your source computer. To install this driver, perform the following actions: 

1 Connect your Mac and your source computer with the Parallels USB cable supplied with 
your Switch To Mac kit. The Found New Hardware Wizard will start. 

2 In the Welcome window, select the Yes, this time only option and click Next. 
3 In the next window, select the Install the software automatically (Recommended) option and 

click Next. 
4 The Hardware Installation warning will appear. Click Continue Anyway to start the 

installation. 

5 When the installation is finished, you will see the Completing the Found New Hardware 
Wizard window. Click Finish to exit the wizard. 
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Installing Parallels Transporter Agent in Linux 
To begin the Parallels Transporter Agent installation, locate the installation file. There are two 
ways to do it: 

 Insert the Parallels Desktop installation DVD in your CD/DVD-ROM drive and locate the 
parallels-transporter-agent.run file in the /Linux directory on the disc. 

 If your computer cannot read DVD discs, download Parallels Transporter Agent for Linux 
from the Parallels Download Center. 

Note: You must have root privileges to install Parallels Transporter Agent in Linux. 

Installing Parallels Transporter Agent 
1 Execute the Parallels Transporter Agent installation file (with the .run extension). 

2 In the introduction window, select Next and press Enter. 

3 Carefully read the Parallels end user license agreement. If you agree with the terms of the 
license agreement, select Accept and press Enter to start installing Parallels Transporter 
Agent on your computer. 

Note: Choosing Decline terminates the installation. 

4 After Parallels Transporter Agent has been successfully installed, select Exit and press Enter 
to complete the installation. 

 

Removing Parallels Transporter 
Agent 

This section provides instructions on removing Parallels Transporter Agent from your source 
computer. 
 

Removing Parallels Transporter Agent From Windows 
Parallels Transporter Agent can be removed in two ways: 

 Choose Control Panel > Add or Remove Programs from the Windows Start menu, select 
Parallels Transporter Agent in the programs list, and click Remove. 

 Double-click the Parallels Transporter Agent installation file. This will start the Setup 
wizard that will help you remove the program. 

Note: You must have administrator rights to remove Parallels Transporter Agent. 
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Removing Parallels Transporter Agent From Linux 
To remove Parallels Transporter Agent from Linux: 

1 Execute the Parallels Transporter Agent installation file (this is the same file you used for 
installing Parallels Transporter Agent). 

2 In the introduction window, select Next and press Enter. 

3 In the next window, select Remove and press Enter. 

4 When Parallels Transporter Agent is successfully removed, select Exit and press Enter to 
close the wizard. 
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To fully run Parallels Desktop Switch to Mac, you should activate it with an activation key. If 
you purchased a boxed version of the program, you can find the activation key printed on the 
installation CD sleeve. If you purchased the program online, the activation key was sent to you 
by email. If you downloaded a copy of Parallels Desktop Switch to Mac to evaluate it before 
buying, you can get a trial activation key valid for a certain period of time. 

After you activate your copy of Parallels Desktop Switch to Mac, you can run virtual machines, 
install operating systems and various applications in them. 

If you upgraded Parallels Desktop to version 6 from the previous version, you need an upgrade 
activation key to activate Parallels Desktop 6. For detailed information, see the Upgrading to 
Parallels Desktop 6 section of Parallels Desktop Switch to Mac User's Guide. 

Activating Your Copy of Parallels Desktop Switch to Mac 

To activate Parallels Desktop Switch to Mac: 

1 Choose Activate Product from the Parallels Desktop menu. 

2 In the activation dialog, type your product activation key into the Activation Key field and 
click Activate to activate your copy. 

 

Now that your copy of Parallels Desktop is active, you need to register it. 
 

Activating Parallels Desktop 
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To start Parallels Desktop, open the Applications folder in Finder and double-click Parallels 
Desktop. 

 

When you start Parallels Desktop, its icon will appear in the Dock. 

To add the Parallels Desktop icon to the Dock, do one of the following: 

 If Parallels Desktop is currently open, right-click its icon in the Dock and choose Keep in 
Dock from the shortcut menu. 

 Open the Applications folder in Finder and drag the Parallels Desktop icon to the Dock. 

When you open the program for the first time, you will see the Welcome window that will help 
you start working in Parallels Desktop. 

In This Chapter 
The Welcome Window ......................................................................................................... 17 
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The Welcome Window 
When you start Parallels Desktop for the first time, the Parallels Desktop Switch to Mac welcome 
window appears. A short introduction video starts and a Parallels expert welcomes you and 
explains what you can do in this window. The welcome window provides you with fast access to 
the most common Parallels Desktop dialogs and assistants, which is especially useful when first 
using Parallels Desktop. 

From the welcome window, you can navigate between the following options: 

 Learn your Mac. This option appears after the introduction video ends. This option allows 
you to watch the Learn Your Mac video tutorial. 

 New Windows installation. This option allows you to launch New Virtual Machine Assistant 
to create a virtual machine with a Windows, Linux, Mac OS X, or any other supported guest 
operating system. 

Note: If you just close the assistant without completing the creation, you will return to the 
Welcome screen. 

 Migrate Windows from PC. This option allows you to transfer the whole of a physical 
Windows computer to a Parallels virtual machine running on your Mac. The source 
computer data will be transferred using Parallels Transporter. To learn more about this 
utility, refer to Parallels Transporter User's Guide. 

 Use your virtual machines. If you have any virtual machines registered in Parallels Desktop 
Switch to Mac, this option opens the Parallels Virtual Machines list with these virtual 
machines. If you have no virtual machines registered in Parallels Desktop Switch to Mac, 
this option launches New Virtual Machine Assistant. 
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Parallels Transporter enables you to move your Windows computer with all its files and 
applications to a Parallels virtual machine on your Mac. To move your computer, you can use 
one of the following ways of transferring the data: 

 using the Parallels USB cable (p. 19), or 
 over Network or FireWire (p. 23), or 
 using an external storage device (p. 27). 

In addition to these types of migration, Parallels Transporter allows you to transfer data from the 
Boot Camp partition. You can transfer Linux computers as well. The migration process in the 
same as for Windows. For detailed information, please refer to Parallels Transporter User's 
Guide. 

In This Chapter 
Using Parallels USB Cable ................................................................................................... 19 
Using Network or FireWire .................................................................................................. 23 
Using an External Storage Device ........................................................................................ 27 
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Using Parallels USB Cable 

Warning: Product re-activation may be required in order to migrate some software 
applications. 

To perform this type of migration, the source and host physical computers must be connected 
with each other by means of the Parallels USB cable. The Parallels USB cable is sold with 
Parallels Desktop Switch to Mac Edition. This migration method is available for Windows 7, 
Windows Vista, and Windows XP source physical computers only. 

Note: If you are going to migrate the source Windows XP computer, you will have to install the 
Parallels USB cable driver on the physical source computer. For detailed information, see 
Installing Parallels Transporter Agent in Windows (p. 11). 

Migrating From a Remote Computer Using the Parallels USB Cable 
1 Turn on your Mac and the source computer, log in, and connect the computers with the 

Parallels USB cable. 

2 On the source Windows computer, start Parallels Transporter Agent by selecting Start > 
Program Files > Parallels > Parallels Transporter Agent. 
The Parallels Transporter Agent window will appear. 
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Do not close this window until the migration is finished. 

3 On your Mac, start Parallels Desktop and choose Import from the File menu to start Parallels 
Transporter. 

4 In the Welcome to Parallels Transporter window, select Parallels Transporter Agent is open on 
the source PC and click Continue. 

5 In the Migration Method window, select the Parallels USB cable option and click Continue. 

6 If the Parallels USB cable is plugged in, in the Connect the Source Computer to Your Mac 
window, you will see the Ready to connect status. Click Continue. Parallels Transporter will 
connect to Parallels Transporter Agent and collect information about the source computer. 
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7 In the Automatic Logon window, you can enable the automatic logon. If you enable it now, 
you will not have to provide your user account password each time you start the virtual 
machine. 

If you do not want to enable automatic logon, select Do not enable Automatic Login. When 
finished, click Continue. 

8 In the next step, choose the level of integration between your Windows and Mac 
applications and files. You can choose one of the following ways to work with your 
Windows applications: 

 Like a Mac: If you select this option, the files located on the desktop, as well as the 
contents of the documents, pictures, music, videos, and downloads folders of the current 
user will be copied from the Windows physical computer to the corresponding locations 
on your Mac. In addition, all of the bookmarks on the Windows physical computer 
Internet browser(s) will be added to the default Internet browser on your Mac. 

 Like a PC: If you select this option, your Windows will run in a separate window, and 
your Mac files will not be shared with Windows, but you will be able to drag and drop 
files between the systems, as well as copy text. 
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When finished, click Continue. 

9 In the Select Name and Location window, specify the resulting virtual machine or hard disk 
name and location on the host computer. When ready, click Continue. 

 
10 If you are migrating a Windows source computer, in the next step, you will see the warning 

message concerning the Windows activation key. To proceed, read this message, select I 
want to continue and click Migrate. 

11 After the migration is complete, click Done in the Migration was completed successfully 
window to quit Parallels Transporter. You can also close the Parallels Transporter Agent 
window on the source computer. 

After quitting Parallels Transporter, you can start using your virtual machine. Open it in 
Parallels Desktop Switch to Mac and install Parallels Tools in it. 

Note: To be able to install Parallels Tools on a Windows virtual machine, you should log in to 
its operating system as an administrator. 
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Using Network or FireWire 

Warning: Product re-activation may be required in order to migrate some software 
applications. 

When migrating over network, your source and host computers must be connected to the same 
network. 

Note: If you are going to migrate a Windows computer, make sure that the Windows Firewall is 
turned off. You can turn it on after the migration is finished. 

For migrating the Windows XP source computers, you can also use the FireWire connection. 
You can try to migrate a source computer with Linux or other Windows operating systems using 
FireWire, but it may require installing additional drivers or setting certain parameters. For 
migrating using FireWire, you should have the FireWire cable and FireWire ports in your source 
and target computers. The procedure for migrating using FireWire is the same as migrating over 
network. 

Migrating From a Remote Computer Over Network 
1 Turn on your Mac and the source computer. Make sure that the computers are connected 

over network. 

2 Start Parallels Transporter Agent on the source computer: 

 In Windows, click the Windows Start menu and choose All Programs > Parallels > 
Parallels Transporter Agent. 

 In Linux, click the Applications menu and choose System Tools > Parallels Transporter 
Agent. 

The Parallels Transporter Agent window will appear. 
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Do not close this window until the migration is finished. 

3 On your Mac, choose Import from the Parallels Desktop Switch to Mac File menu to start 
Parallels Transporter. 

4 In the Introduction window, select Parallels Transporter Agent is open on the source PC and 
click Continue. 

5 In the Migration Method window, select the Network option and click Continue. 

6 In the Connecting to Parallels Transporter Agent window, select your Windows computer 
name from the list of detected computers and click Continue. 
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7 Provide the source computer administrator credentials when prompted. Parallels Transporter 
will connect to Parallels Transporter Agent and collect information about the source 
computer. 

8 In the Automatic Logon window, you can enable the automatic logon. If you enable it now, 
you will not have to provide your user account password each time when starting the virtual 
machine. 

If you do not want to enable automatic logon, select Do not enable Automatic Logon. When 
finished, click Continue. 

9 In the next step, choose the level of integration between your Windows and Mac 
applications and files. You can choose one of the following options of working with your 
Windows applications: 

 Like a Mac: If you select this option, the files located on the desktop, as well as the 
contents of the documents, pictures, music, videos, and downloads folders of the current 
user will be copied from the Windows physical computer to the corresponding locations 
on your Mac. In addition, all of the bookmarks on the Windows physical computer 
Internet browser(s) will be added to the default Internet browser on your Mac. 

 Like a PC: If you select this option, your Windows will run in a separate window, and 
your Mac files will not be shared with Windows, but you will be able to drag and drop 
files between the systems, as well as copy text. 
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When finished, click Continue. 

10 In the Select Name and Location window, specify the resulting virtual machine or hard disk 
name and location on the host computer. When ready, click Continue. 

 
11 If you are migrating a Windows source computer, in the next step, you will see the warning 

message concerning the Windows activation key. To proceed, read this message, select I 
want to continue and click Migrate. 

12 After the migration is complete, click Done in the Migration was completed successfully 
window to quit Parallels Transporter. You can also close the Parallels Transporter Agent 
window on the source computer. 

After quitting Parallels Transporter, you can start using your virtual machine. Open it in 
Parallels Desktop Switch to Mac and install Parallels Tools on it. 

Note: To be able to install Parallels Tools on a Windows virtual machine, you should log in to 
its operating system as an administrator. 
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Using an External Storage Device 
The migration process using an external storage device consists of three main stages: 

1 Migrating the source computer data to a Parallels virtual machine with the help of Parallels 
Transporter Agent. The virtual machine is saved on a USB drive or another removable 
storage device connected to the source computer. 

2 Disconnecting the storage device from the source computer and connecting it to the host 
computer (your Mac). 

3 Migrating the resulting virtual machine to the host computer from the storage device with 
the help of Parallels Transporter. 

Warning: Product re-activation may be required in order to migrate some software 
applications. 

Migrating the Source Computer to the External Storage Device 
1 Connect an external storage device to your source computer. 

2 Start Parallels Transporter Agent on the physical source physical computer: 

 In Windows, click the Windows Start menu and choose All Programs > Parallels > 
Parallels Transporter Agent. 

 In Linux, click the Applications menu and choose System Tools > Parallels Transporter 
Agent . 

3 The Parallels Transporter Agent window will appear. Click the external storage device icon 
to start the Parallels Transporter Agent wizard. 
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4 In the Connecting External Storage window, click Next. Parallels Transporter Agent will 
collect information about the source computer. 

5 In the Automatic Login window, you can provide your Windows account password (This is 
the password you use to enter your desktop on a regular basis). If you provide the password 
now, you will not have to provide it each time you start the Windows virtual machine. 

If you want to provide your Windows account password now, type it in the Password field. 
If you do not want to enable automatic logon, select Do not enable Automatic Logon. When 
finished, click Next. 

6 In the Select Name and Location window, specify the virtual machine name and location on 
the storage device. You can specify any location on your source computer. After Parallels 
Transporter finishes the migration to the specified location, you will have to transfer the 
virtual machine .pvm file using an external storage device, or CD/DVD disc, or via the 
Internet to your Mac. When ready, click Next. 
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7 In the next step, you will see the warning message concerning the Windows activation key. 
To proceed, read this message, select I want to continue, and click Migrate. 

8 After the migration is complete, click Finish to quit Parallels Transporter Agent. 

9 Disconnect the storage device from the source computer, and connect it to your Mac. 

Migrating the Virtual Machine to Your Mac 
1 On your Mac, choose Import from the Parallels Desktop Switch to Mac File menu to start 

Parallels Transporter. 

2 In the Introduction window, select Parallels Transporter Agent is open on the source PC and 
click Continue. 

3 In the Migration Method window, select the External storage device option and click 
Continue. 

4 In the Preparing to Copy window, you should provide the path to the resulting virtual 
machine on the storage device. Click the Choose button and locate the virtual machine's 
bundle (.pvm). Click Continue. 
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5 In the next step, choose the level of integration between your Windows and Mac 
applications and files. You can choose one of the following ways to work with your 
Windows applications: 

 Like a Mac: If you select this option, the files located on the desktop, as well as the 
contents of the documents, pictures, music, videos, and downloads folders of the current 
user will be copied from the Windows physical computer to the corresponding locations 
on your Mac. In addition, all of the bookmarks on the Windows physical computer 
Internet browser(s) will be added to the default Internet browser on your Mac. 

 Like a PC: If you select this option, your Windows will run in a separate window, and 
your Mac files will not be shared with Windows, but you will be able to drag and drop 
files between the systems, as well as copy text. 

 
When finished, click Continue. 

6 In the Select Name and Location window, specify the resulting virtual machine name and 
location on the host computer. When ready, click Migrate. 

7 After the migration is complete, click Finish to exit the wizard. 

After quitting Parallels Transporter, you can start using your virtual machine. Open it in 
Parallels Desktop Switch to Mac and install Parallels Tools in it. 

Note: To be able to install Parallels Tools on a Windows virtual machine, you should log in to 
its operating system as an administrator. 
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Once your Windows computer is transferred to a Parallels virtual machine on your Mac, it is 
recommended that you install Parallels Tools which provide a seamless integration for your Mac 
and virtual machine enabling you to run Windows and Mac applications side by side.  

This section outlines Parallels Tools installation as well as the basic operations, visual modes, 
and virtual machine configuration tips. 

In This Chapter 
Installing and Updating Parallels Tools ................................................................................ 31 
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Changing View Modes.......................................................................................................... 33 
Configuring the Virtual Machine .......................................................................................... 34 
 
 

Installing and Updating Parallels 
Tools 

To install or update Parallels Tools: 

1 Start the virtual machine and log in to the guest operating system. 

2 Choose Install Parallels Tools (or Update Parallels Tools) from the Virtual Machine menu. 

Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools can be 
installed in your guest operating system. To see the list of guest OSs supported by Parallels 
Tools refer to the Parallels Tools Overview section in Parallels Desktop Switch to Mac Help 
available through the Help menu. 

3 The Parallels Tools installation wizard will open. 

4 In the Welcome window click Install. The wizard will start the automatic installation. 

5 When the installation is complete click Reboot to exit the wizard and restart the virtual 
machine. 

For more detailed procedures on installing Parallels Tools refer to the Parallels Desktop Help 
available from the Help menu. 
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Working With the Virtual Machine 

Opening the Virtual Machine 

To open the virtual machine, start Parallels Desktop and click Use your virtual machines in the 
Welcome window. If you have only one virtual machine in Parallels Desktop, its window will 
open. If you have several virtual machines, you will see the Parallels Virtual Machines list. To 
open the virtual machine window, click its name on the list. 

Later on you can open the Parallels Virtual Machines list by choosing Virtual Machines List from 
the Window menu. 

Changing the Virtual Machine State 

You can start, shut down, suspend, or otherwise manage the virtual machine state using the 
Virtual Machine State menu  in the lower left corner of the virtual machine window. Click 
the Virtual Machine State button  and select the desired command from the menu: 

 

You can also use the Parallels Virtual Machines list and the Virtual Machine menu controls to 
start, stop, pause, suspend, resume, reset, or shut down the virtual machine. 

Managing the Virtual Machine Devices 

The status bar at the bottom of the virtual machine window displays the virtual machine's 
devices icons and the menus for managing the virtual machine view mode and state. You can 
easily connect or disconnect the devices using the devices icons on this bar: right-click the 
device icon and choose the necessary option from the shortcut menu. 

 

To add devices to the virtual machine configuration, use the Virtual Machine Configuration dialog 
(p. 34). 
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Changing View Modes 
In a running virtual machine, you can switch between the following view modes: 

 Window mode. In this mode, the virtual machine screen is displayed as a separate window. 
This is the default view mode. 

 Full Screen mode. In this mode, the virtual machine screen is expanded to occupy the whole 
of your physical computer's screen. 

 Coherence mode. In this mode, the virtual machine desktop is invisible so that you can see 
the virtual machine applications windows in Mac OS X and work with them side by side 
with your Mac OS X applications. 

 Modality mode. In this mode, you can view the virtual machine and the programs running 
inside it in a transparent scaled window while working in Mac OS X. By default, this 
window appears on the top of all open windows, so you can supervise your virtual machine 
while you work in Mac OS X. 

To change view modes, use the View Mode menu in the lower right hand corner of the virtual 
machine window. 

 

Note: You can change the virtual machine view mode only when the virtual machine is running. 
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Configuring the Virtual Machine 
The configuration of an existing virtual machine can be changed in the Virtual Machine 
Configuration dialog. You can open this dialog by doing one of the following: 

 Choose Configure from the Virtual Machine menu. 
 In the Parallels Virtual Machines list, right-click the virtual machine and choose Configure. 

 

Virtual Machine Configuration allows you to configure your virtual machine in a variety of 
ways. For example, you can 

 Configure the virtual machine general options in the General window. 
 Define the virtual machine boot options in the Boot Order pane of the Hardware window. 
 Configure different parameters of the devices currently available inside the virtual machine: 

hard disk drives, CD/DVD-ROM drives, floppy disk drives, etc. 
 Configure the resource values currently set for the virtual machine: main memory, video 

memory, CPU, etc. 
 Add a new device to the virtual machine or remove an existing one. 

Detailed information on all of the settings you can configure in the Virtual Machine Configuration 
dialog can be found in the Parallels Desktop User's Guide. 
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Parallels Desktop provides several ways to access the necessary information: 

 Parallels Desktop Help. Parallels Desktop Help contains extensive information about the 
product and its usage. To open Parallels Desktop Help, choose Parallels Desktop Help from 
the Parallels Desktop Help menu. 

 Context-sensitive help. In most windows, you will find a help button  opening the 
corresponding help page. 

 Online documentation (http://www.parallels.com/products/desktop/stm50_docs-en_US). This 
page provides PDF documentation for Parallels Desktop and Parallels Transporter. To open 
the online documentation page, choose Online Documentation from the Parallels Desktop 
Help menu. 

 Parallels website (http://www.parallels.com). Explore the Support web page that includes 
product help files and the FAQ section. 

 Parallels Knowledge Base (http://kb.parallels.com/). This online resource provides 
troubleshooting for problems that may occur when using Parallels Desktop and other 
Parallels products. 

In This Chapter 
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Feedback 
If you spot a typo in this guide, or if you have an opinion about how to make this guide more 
helpful, you can share your comments and suggestions with us by completing the 
Documentation Feedback form on our website (http://www.parallels.com/en/support/usersdoc/). 
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